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Вход в систему 

Для входа в STERLING TRADER PRO, нажмите на ярлык на рабочем столе, чтобы 

вызвать Окно Входа. 
 

Просто введите ваше имя трейдера и пароль, нажмите на кнопку Войти (Login)! 
 

➢ Пароли чувствительны к регистру. Перед входом в учетную запись проверьте 

Caps Lock. 

 

ВЫХОД ИЗ ПЛАТФОРМЫ 

В главном меню нажмите левой кнопкой мыши на меню Actions и выберите Exit. 

Или нажмите кнопку X в правом верхнем углу главного меню. 
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Часть 1 – STERLING TRADER PRO – Главное меню 

Все окна программы Sterling Trader Pro являются плавающими. Main Menu – не 

исключение. 

 

В этом окне вы можете открывать новые окна платформы. Делается это с помощью 

меню Windows или щелчком левой кнопкой мыши по соответствующему значку в 

верхней панели задач. 

Из этого окна Вы также можете управлять layout (личными настройками) и 

системными настройки. 

Ниже приводится краткое изложение пунктов меню, доступных в главном меню. 

 
ACTIONS MENU– управление личными настройками 

Слева кликните на меню Action и вы увидите следующие настройки layouts 
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• Load Layout – загрузить личные настройки. 

• Save Layout – сохранить личные настройки. 

• Save Layout As – тоже позволяет сохранить личные настройки, но в данном 

случае им можно присвоить свое имя. 

• Edit Password – поменять пароль. 

• Restore All – сбросить все настройки. 

• Minimize – свернуть все окна. 

• Close All – закрыть все окна 

 

Создание копии Sterling Trader Pro. В приведенном выше меню вы можете создать 

резервные копии всех ваших Sterling Trader Pro файлов. 

1. В меню Actions нажмите на кнопку "Create Backup ..." 

2. Появится меню с запросом выбора папки для сохранения резервной копии. 

3. Выберите папку и нажмите кнопку ОК. Резервное копирование всех ваших 

Sterling Trader Pro файлов будет добавлено в эту папку. 

 

VIEW MENU – управление параметрами 

Слева – кликните на меню View – это дает вам возможность настроить глобальные 

настройки по ордерам. В меню View Вы также можете получить доступ к 

информации по серверам и создать свой список акций для их просмотра в окне 

Stock Watch. 
 

➢ Информация о сервере, как правило, используется, если у вас возникли 

проблемы с данными, и вы нуждаетесь в службе технической поддержки. 
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WINDOWS MENU – открытие новых окон 

Нажатие левой кнопкой мыши на меню Windows предоставляет большое 

количество вариантов для передачи данных, а именно предоставляются торговые 

окна платформы Sterling Trader Pro. При нажатии на любую ссылку, откроется окно. 

Все окна подробно рассматриваются в последующих главах. 
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Часть 2 – Глобальные параметры 

Глобальные настройки ордеров – по умолчанию это контроль параметров для 

управления окнами (Level I Order Entry, Level II Order Entry и т.д.). Из этого окна Вы 

также можете настроить горячие клавиши и торговые уведомления. Вы должны 

ознакомиться с этими настройками, потому что они контролируют многие аспекты 

платформы, и Вы часто будете к ним возвращаться. 

Чтобы получить доступ к общим настройкам, в главном меню нажмите на кнопку 

"View" и "Settings". Появится следующий экран: 
 

В левой панели вы увидите список категорий, параметры которых Вы сможете 

настраивать. Рассмотрим их по порядку, за исключением клавиш, которые будут 

иметь свое специфическое назначение. Правая панель показывает настройки, 

которые можно настроить для каждой категории. 

Некоторые настройки воздействуют на определенные окна для того, чтобы иметь 

локальный порядок настроек (Level I О.Е., Level II OE и др.). 

Во вкладке GENERAL производятся главные настройки, основные из них: 

• When starting the application позволяет определить личные настройки при 

запуске терминала. Есть возможность загружать определенные настройки или 

последние используемые. 

• С помощью When exiting the application можно поставить запрос 

подтверждения на выход из программы, а также сохранять текущие настройки 

при выходе из терминала. 
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• Profit/Loss позволяет настроить отображение нереализованной 

прибыли/убытка для акций и опционов и т.д. Можно рассчитать 

нереализованную прибыль/убыток (P/L) с использованием последней цены 

или текущих цен Bid/Ask. Если вы выберете Last Price, вы можете выбрать 

для использования цены закрытия предыдущего дня. 

Также в данной вкладке настроек есть возможность выбора языка. 

 
Во вкладке QUOTES проводятся настройки котировок, такие как: 

• Отображение котировки в сотнях, отрицательные цены в скобках, и другие 

визуальные решения. 

• Настройка вашей модели ценообразования. 

• Можно установить, сколько знаков после запятой вы увидите в вашем окне 

котировок. 
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Во вкладке NOTIFICATIONS настраиваются параметры уведомлений терминала. 

Например, вы можете выбрать для отображения сообщения, когда ордер выполнен, 

или, когда будет отклонен, или вы можете настроить звуковые уведомления. Более 

подробные уведомления доступны в окне MESSEGES. 
 

Вкладка EQUITIES позволяет установить свои значения по умолчанию для 

предварительного выполнения ордеров с указанным количеством. Вы также можете 

установить по умолчанию цены (Bid, Ask, MKT, и т.д.) 
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Чтобы по умолчанию установить ввод ордера до 100 акций на новые позиции, 

укажите значение - 100 в поле "Qty to open position". Или укажите значение, 

которое Вы хотите. 

Для установки значения цены, по умолчанию, для открытого рынка и пре-маркета: 

1. Проверьте, установлена ли галочка напротив "Price". 

2. Для "If buying" и "If selling", выберите в выпадающем окне Bid, Ask, MKT, и 

last. 

3. Если Bid, Ask, MKT, и last выбраны, могут быть использованы стрелки 

вверх/вниз для расчета сложения или вычитания из этой цены (например, Bid 

+.01 или Last - .02) 

4. При необходимости выберите STP во втором выпадающем окне 

предварительного выполнения ордеров для стоп-ордеров. 

5. Повторите эти действия для пре-маркета. 
 

Проверьте "Display Price as Number", если вы не хотите видеть (BID), (ASK), (Last), 

и т.д. Вместо этого, в поле цены будет отображаться фактическое число. 

 
LISTING EXCHANGES 

Это окно может показаться запутанным на первый взгляд, но после того, как вы 

начнете его использовать, вы начнете осознавать все его преимущества. Окно 

"Listing Exchanges Settings" дает вам возможность указать по умолчанию обмен - 

акциями, опционами, фьючерсами. 
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Установка по умолчанию для акций: 
 

1. Сделав двойной щелчок в поле Dest, Вы получите выпадающее меню 

доступных маршрутов. 

2. Выберите маршрут. 

3. Повторите эти действия для "Futures" и "Options" в случае необходимости и 

для "Forex" (Forex в настоящее время не торгуется на Sterling Trader® Pro). 

Вы можете все повторить и для CoverDest. Ваш CoverDest может быть одинаковым, 

или отличаться от вашего Dest. Это определяется только предпочтениями 

пользователя. 

Вы можете установить значения по умолчанию для акций путем деления на листинг 

биржи (NYSE, NASDAQ, или OTC-BB). Это означает, что вы можете по умолчанию 

выставить различные назначения для NYSE, различные назначения на NASDAQ, и 

т.д. 

1. Нажмите кнопку "Add". Появится новая линия. 

2. В столбце ListExch, сделайте двойной щелчок, чтобы получить курсор и 

введите букву N (NYSE) или Q (NASDAQ), или Т (OTC-BB). 

3. После дважды щелкните в колонке Dest для выбора ECN. 
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DESTINATIONS – назначение ордера (биржи, ECN, на которых будет исполнен 

ваш ордер). Так называемый - маршрут ордера. 
 

В приведенном выше примере выбран Destination (маршрут ордера) - ARCA, 

Account – ваша учетная запись, TIF (Time-In-Force) - DAY, Display Quantity 

(количество акций) - 100 (если это ордер резервный). Таким образом, если в окне 
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ввода ордеров Вы выбираете ECN - ARCA, поля ввода ордеров будут обновлять 

остальные значения по умолчанию. 

➢ В колонке MinQty должно быть установлено значение – Any, так как этот 

параметр больше не поддерживается. 

Вы также можете выбрать биржи, ECN для каждого из назначенных ордеров. 

 
LEVEL II OE 

Эта категория влияет только на Level II OE. Этот экран имеет те же значения по 

умолчанию, как и Level I OE и выше, но вводит дополнительные настройки для Level 

II. 

 
 
Level II OE автоматически создает окно для заполнения ввода ордеров с ценой и 

назначением. 

Single-Click Routing... 

1. Установите флажок "Enable single-click routing" и выберите Custom routing. 

2. Нажмите кнопку для вызова экрана Custom Routing. 

3. Нажмите кнопку "Add", чтобы добавить экран маршрутизации (Route). 

4. Введите MMID и выберите пункт назначения для маршрутизации. 

5. Нажмите кнопку ОК. Вы увидите MMID и связанные с ними маршрут на экране 

маршрутизации клиентов. 

6. Повторите эти действия для каждой требуемой MMID. Или, вы можете нажать 

предварительное заполнение ECN, который заполнит все пункты назначения, 

как MMID к тому же пункту назначения. Оттуда вы можете редактировать их по 

отдельности. 
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KEYBOARD – Этот экран позволяет настроить шаг регулировки цены с помощью 

стрелок на клавиатуре - вправо, влево. 
 

В разделе "Others" есть опция, которая позволяют отправить ордер на биржу, нажав 

на клавишу Enter и/или клавишу Enter на цифровой клавиатуре. 

➢ Будьте аккуратны при использовании этих кнопок. 

 
MESSAGES 

В этом окне вы можете управлять сообщениями, которые могут появляться или нет в 

различных случаях (например, сообщения которые подтверждают отправку ордера) 
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Последний пункт, "Sending a Sell Long order would result in multiple open Sell 

Long orders", может быть эффективным инструментом для защиты от случайно 

открытых коротких позиций. 

Вы также можете выбрать получение предупреждающего сообщения, если ваш 

ордер определенного выше или ниже Bid/Ask. Данную опцию можно настроить как 

для акций, так и для опционов. 

 

MISCELLANEOUS 

В этом окне вы можете настроить скользящие стопы (Trailing stop), выбрать Smart 

SWIPE ордера и направления для них. 
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Часть 3 – Горячие клавиши 

Sterling Trader® Pro включает возможность отправки ордеров с использованием 

горячих клавиш. Есть также ряд уже заданных горячих клавиш для отправки и 

отмены ордеров. 

PRESET HOT KEYS – эти горячие клавиши уже есть в системе. Они показаны, 

синим цветом. Вы можете их редактировать, активировать и так далее, но вы не 

можете изменять основные, базовые параметры. 

 
 

На экране есть полоса прокрутки справа, это означает, что есть много других 

предустановленных горячих клавиш. Дважды щелкните на горячую клавишу, чтобы 

получить более подробное описание. Вот основные типы заданных горячих клавиш: 

• Отмена ордеров (CXL All, CXL All Buy и т.д.) 

• Закрытие ордеров (CVR All, CVR All short и т.д.) 

• И другие, такие как свернуть все окна, восстановление, и переключения 

фильтра. 

Чтобы изменить или добавить горячую клавишу: 

1. Дважды щелкните левой кнопкой мыши на поле "Action", чтобы выбрать 

горячую клавишу, которую вы хотите обновить (или выделите ее и нажмите 

кнопку "Edit..."). Появится окно Edit Special Hot Key. 

2. Для установки новых горячих клавиш, нажмите нужную комбинацию на 

клавиатуре, и в окне добавится новая горячая клавиша. 

3. Для того чтобы отключить горячую клавишу нажмите Delete. 

4. После этого, нажмите кнопку ОК. 
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Часть 4 – Данные по рынку 

Из большинства окон Sterling Trader® Pro в режиме реального времени могут быть 

доступны данные по рынку. В этой главе мы будем рассматривать окна: Stock 

Watch, Level II и Time And Sales. 

 

STOCK WATCH 

Stock Watch – это список активных акций, которые вы смотрите в данный момент. 

Чтобы открыть окно Stock watch, перейдите в главное меню. Во вкладке Windows 

выберите пункт меню Quotes - Stock watch. По умолчанию Вы получите пустое окно 

Stock watch: 
 

 

CREATING A WATCH LIST 

Для создания своего списка акций кликните на меню "Actions" и выберете "New 

List". 
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INSTERTING LABELS AND BLANK ROWS 

Вы можете организовать свой контрольный список, добавляя ярлыки или пробелы 

для разделения групп символов. 
 

 

Вы можете сортировать столбцы нажатием левой кнопкой мыши на заголовок 

столбца. Любые знаки и пустые строки будут отсортированы. 

Чтобы сохранить ваш список акций в Stock Watch: 

1. Нажмите на меню Action. 

2. Нажмите SAVE. 

3. Если это новый список, присвойте ему имя и нажмите кнопку сохранить. 
 

Чтобы загрузить сохраненный список акций: 

1. Нажмите на меню Action. 

2. Нажмите на Load. 

3. Выберите нужный список, который был сохранен, и нажмите кнопку Open. 
 

Чтобы удалить строку, просто выделите нужную строку и нажмите клавишу Delete на 

клавиатуре. 
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DATA COLUMNS (Столбцы данных) 

Вы найдете доступные столбцы в меню View в разделе Settings. 

Чтобы добавить или удалить столбец, просто установите или снимите флажок рядом 

с именем столбца. 

 

Как только вы выберете необходимые столбцы данных (Colums), вы сможете 

установить порядок их расположения на экране. 

Чтобы изменить порядок ваших столбцов: 

1. Щелкните левой кнопкой мыши и удерживайте заголовок столбца. 

2. Переместите заголовок столбца на желаемое место. 
 

Вы также можете переместить отдельные строки вверх и вниз: 

1. Щелкните правой кнопкой на строку, которую нужно передвинуть. 

2. Во всплывающем меню, выберите переместить строку вверх (Move Row Up) 

или переместить строку вниз (Move Row Down). 

3. Вот и все. Строка будет двигаться на одно место вверх или вниз, в 

зависимости от того, что вы выбрали. 

 

HIGHLIGHTING – цветовое выделение в окне Stock Watch. Для настройки 

цветового выделения перейдите в меню View – Settings, а затем перейдите в 

раздел Miscellaneous. 
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DOUBLE CLICK SETTINGS 

Двойной щелчок на символ в Stock watch может иметь несколько эффектов, 

которые можно настроить во вкладке "Other". 

Edit Symbol – двойной щелчок позволит вам ввести новый символ. 

Set Link Symbol – двойной щелчок на символе в окне Stock Watch заполнит этот 

символ в другие окна в вашей группе связанных между собой окон. 

Switch to Focus Window – двойной щелчок переключает текущее окно в указанное 

окно фокусировки. Например, если основное внимание было на окне Level II OE, 

двойной щелчок на символ приведет к переключению на Level II OE и заполнит окно 

Level II OE символом, на который вы нажали, делая отправку ордеров Level II OE 

быстрее. 

Open Level I, Open Level II, Open Mini, Open Chart, Open Exchange Alerts - 

Двойной щелчок открывает эти окна. 
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LEVEL II OE 

Это окно называется LEVEL II OE (окно второго уровня котировок): 

Окно LEVEL II показывает глубину рынка. В окне настроек вы сможете выбрать те 

данные, которые вы желаете видеть. 

Чтобы получить доступ к настройкам: 

1. Щелкните левой кнопкой мыши на меню View. 

2. Выберите Settings. 

3. Выберите General или Level II. 
 

Во вкладке General можно выбрать следующие функции: 

1. Вы можете выбрать цветовое выделение по цене в Level II. 

2. Для изменения необходимо выбрать структуру цвета в выпадающем окне и 

выбрать то, чтобы вы желаете изменить. 
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Вы можете настроить: 

1. Фильтр из нечетных лотов. 

2. Показ открытых ордеров в Level II. 

3. Отображение времени в секундах. 

4. Выделение маркет-мейкеров. 
 

Для выделения конкретных участников рынка ценных бумаг: 

1. Установите галочку: "Highlight specific market makers". 

2. Нажмите кнопку "Makers ...". Откроется окно "Highlighted Makers". 

3. Введите символ или символы маркет-мейкеров, которые вы хотели бы 

выделить. 

4. Нажмите кнопку "Add", чтобы заполнить список. 

5. Нажмите кнопку ОК. 
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6. В окне второго уровня котировок, вы увидите следующую информацию, ECN - 

ARCA выделена синим цветом: 
 



25 
 

 

 

TIME AND SALES 

Отображается каждая сделка для конкретной акции. Показывает время покупки и 

продажи каждой сделки, как правило, отображается в виде: цена, время, размер и 

рынок. Вы также можете расширить список данных Bid/Ask. 

 

 
HISTORICAL DATA – Intraday (просмотр сделок внутри дня) 

Для запроса внутридневных исторических данных установите флажок, справа от 

поля символа, и введите время. 
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Для других настроек ленты принтов: выберите данные во View в окне Time and 

Sales и кликните – Settings: 
 

Во вкладке General вы можете настроить: 

• Выбор отображаемых столбцов. 

• Фильтр сделок по объему 

• Фильтр сделок на определенных рынках. 

Во вкладке Colors, вы можете настроить цветовое выделение по времени и 

продажам: 
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Часть 5 – Графики 

Торговая платформа Sterling Trader Pro позволяет работать с большим количеством 

графиков. Для открытия окна графика достаточно перейти в пункт меню Windows- 

Quotes-Chart. 
 

 
Перед открытием графика нам предлагается вбить тиккер компании: 
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После чего отобразиться график: 

 

 

В верхней панели инструментов есть два меню, Actions и Char. Также в верхней 

панели есть возможность выбирать тайм фрейм: 

 

 
С помощью меню Actions вы можете создать новый график, сохранить его, а также 

загружать имеющиеся списки графиков. 

С помощью меню Chart можно производить настройки графиков, рассмотрим 

основные пункты меню: 
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• Edit Symbol – изменить тиккер компании. 

• Add Indicators –добавлять индикаторы. 

 

 
Добавим индикатор объемов (Volume): 
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Под графиков появится индикатор - Volume. 

 

 

• Bar Style – можно выбрать тип графика: Candle Stick (японские свечи), OHLC 

(бары) или Linear (линейный график). 

 
Candle Stick 



31 
 

 

 

OHLC 

 
Добавлять индикаторы можно и через верхнюю панель инструментов: 

 

 

Также в верхней панели инструментов есть элементы приближения и удаления 

графика, а также кнопки его прокрутки. 

Пункт меню Chat позволяет управлять внешним видом графика, а в окне Settings, 

вы сможете провести различные настройки самого графика: отображение сетки, 

шрифты, цвета и т.д. 
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Нажав на кнопку Colors, появиться возможность изменять цвета. 
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Часть 6 – Ввод ордеров 

Sterling Trader® Pro включает в себя несколько окон для акций, опционов и 

фьючерсов. 

Для акций: 

• Level I Order Entry 

• Level II Order Entry 

 
Для этих окон доступны горячие клавиши и по умолчанию они предварительно 

заполнены в полях ввода ордера. 

 

LEVEL I ORDER ENTRY 

➢ При открытие в главном меню окна LEVEL I Order Entry все поля будут 

пустыми, по той причине, что там нету символа. 

После ввода символа в пустое окно оно активируется, и вы сможете видеть данные 

Level I: цену последнее сделки (Last), цены Bid/Ask, и т.д. 
 

Ниже приведен список полей для ввода ордеров: 

Side – покупка (Buy), продажа (Sell) или открытие короткой позиции (Sell Short). 

Quantity – количество акций для торговли. 

Symbol – символ акций, которыми Вы хотите торговать. 

Цена (Price) предлагает несколько вариантов, в том числе Bid, Ask, MKT, и цену 

Last. Вы всегда можете вручную ввести цену. При выборе Bid, Ask, или цены Last, 

вы можете изменить цену, нажав на стрелки вверх или вниз рядом с полем Price. 

Account – если у вас есть несколько учетных записей можно выбрать одну из них. 

Destination – маршрут ордера. Sterling Trader® Pro предлагает прямой доступ к 

торговле. 

Commission – взимаемая комиссия за торговлю, если доступна. 

Trader – идентификатор пользователя (Trader ID). По умолчанию им нельзя 

манипулировать. 

Price Type – Вы можете выбрать стоп ордера (stop orders) или market-on-close 

ордера. 

Time In Force – выбирается торговый период времени: GTC, открытие рынка, post- 

market, и т.д. 
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Если все необходимые поля заполнены, нажмите на кнопку отправить ордер. 

Если у вас есть открытая позиция, т.е. вы совершили сделку, то она будет 

отображаться в нижней части окна. 

 
STOP ORDERS 

Стоп ордера доступны как один из типов ордера. Вы выбираете стоп-ордера в поле 

Price Type. Есть пять типов: 

• STP (Stop Market) 

• STP LMT (Stop Limit) 

• S-STP (серверный Stop) 

• S-STP LMT (серверный Stop Limit) 

• T-STP (скользящий стоп) 

STP, вы заполняете ваш стоп в поле Price. 

Для STP LMT, введите ваш стоп в поле Price и введите предел цены для лимитного 

ордера в поле Stop Price Limit. 

S-STP и S-STP LMT являются "Серверными" стопами. Пожалуйста, обратите 

внимание, что Sterling Trader, Inc не несет никакой финансовой ответственности за 

сбои в работе системы. Используйте на свой страх и риск. 

Для Traling STOP, изменения цены осуществляется в поле "Trail Amount". 

 
LOCAL ORDER ENTRY SETTINGS 

В меню View выберите пункт Local Order Entry Settings чтобы назначить требуемые 

настройки по умолчанию для данного конкретного окна. Если вы будете открывать 

несколько LEVEL I Order Entry, вы можете установить различные локальные 

параметры записи для каждой из них. Эти параметры переопределяют глобальные 

параметры ордера. Обратите внимание, что в этом окне вы можете установить по 

умолчанию учетные записи и назначения ордеров. 
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Где Set to Global - Настройки по умолчанию. 

 
LEVEL II ORDER ENTRY 

Level I Order Entry крепится к верхней части Level II. 
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LOCAL ORDER ENTRY SETTINGS 

Local order entry settings для Level II похожи на настройки Level I, за одним 

исключением: Вы можете настроить MULTI маршрут, относящиеся к окну Level II. 

 

 
SINGLE-CLICKING IN LEVEL II 

Вы можете настроить окно OE Level II таким образом, что в окне ввода ордеров 

будет происходить обновление цен и/или назначений для ордеров, при нажатии на 

цену в глубине стакана Level II. Однако эту функцию можно отключить в главном 

меню View - Settings… - Level II OE. Для этого стоить убрать галочку Enable single- 

click routing в разделе Clicking: 
 

STOP ORDERS IN LEVEL II OE 

Особое внимание следует уделить стоп ордерам. Для размещения стоп ордера, вы 

должны выбрать STP или S-STP. Если вы хотите выбрать Stop-Market ордер, 

укажите цену для стоп ордера в соответствующее поле для цены. Если вы хотите 

выбрать Stop Limit ордер, сначала укажите цену для стоп ордера в соответствующее 

поле для цены, а затем цену вашего лимитного ордера справа от поля Time-In- 

Force. 
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HOT BUTTON BAR 

В меню View окна Level II OE, вы можете настроить "Hot Button Bar". Hot Button 

Bar, позволит выполнять функции ваших горячих клавиш, а именно отправку и 

отмену ордеров, нажав на кнопку без помощи клавиатуры. 

 
Чтобы настроить панель горячих кнопок: 

1 - В меню View выберите "Hot button Bar setup". 
 

В глобальных настройках "Global Order Entry Hot Key settings", вы должны 

установить ваши горячие клавиши, чтобы использовать их в панели горячих клавиш 

"Hot Button Bar". Для этого: 

1. Выделите горячую клавишу, которую вы хотите добавить на панель и нажмите 

кнопку >>, чтобы переместить ее. 

2. Повторите эти действия для всех нужных клавиш. 

3. В список избранных горячих клавиш, выбрать цвета для этих кнопок. 

4. Нажмите OK. 

 
EXPANDED ORDER ENTRY BAR 

В меню View выберите Expanded Order Entry Bar, чтобы добавить данную функцию 

в окно Level II Order Entry: Резервные ордера и скрытые ордера. 

В развернутой панели есть поле, в котором по умолчанию указано "Ordr Qty" 

(Объем акций). Можно указать объем акций, который будет отображаться в стакане 

заявок, таким образом, на рынок можно отправлять скрытые заявки. 
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CANCELLING OPEN ORDERS IN LEVEL II 

Если вы решили отменить ордер, то в окне Level II нажмите на красный фон 

назначения ордера в стакане заявок (как показано на рисунке, красный фон - BATS). 

И ваш ордер будет отменен. Напротив открытого ордера имеется красный крестик. 

Чтобы отменить этот ордер, нажмите на красный крестик X. 

 

 
OPEN POSITIONS и OPEN ORDERS 

Если у вас есть открытые позиции или открытые ордера, вы можете влиять на них 

через окна Stock Watch и Position Summary следующим образом: 

Для закрытия позиций: 

1. Щелкните правой кнопкой мыши на символ, чтобы открыть всплывающее 

меню. 

2. Выберите Cover. 
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3. У вас есть несколько вариантов, которые показанны выше, что делать с 

позицией (ями). Выберете - закрыть позицию "Cover- Position". 

Для отмены открытых приказов (ордеров) нажмите на символ и выберите Cancel All 

во всплывающем меню. 
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Часть 7 – Trading monitor 

Sterling Trader® Pro предоставляет окно Trading Monitor, который функционирует 

как книга всех ордеров, что позволяет вам контролировать вашу торговую 

деятельность. Есть три монитора: один для Акций, один для фьючерсов и еще один 

для Опционов. 

Чтобы открыть Trading Monitor, необходимо зайти в главное меню, щелкнуть 

Windows и выбрать Trading Monitor. 

В окне, автоматически, будут отображаться сведенья о ваших ордерах, в режиме 

реального времени. Вы можете фильтровать ордера с помощью вкладок в нижней 

части окна: 

• All orders - показывает все ордера за торговый день, будь то открытые 

ордера, закрытые, отмененные, и т.д. 

• Open orders - показывает только текущие открытые ордера. 

• Executions - показывает только ваши исполненные ордера в течение дня. 

• Previous date executions - Вы можете посмотреть исполненные ордера за 

предыдущие дни. 

Для дальнейшей фильтрации данных, которые вы смотрите, щелкнете правой 

кнопкой мыши на заголовок столбца и выберите фильтр - Add/Edit Filter. 

В примере ниже, мы выбрали для фильтрации окно "Filled (исполненные)". 

Нажмите кнопку Filter в правом верхнем углу, чтобы включить фильтр. 
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Теперь вы можете увидеть, что в столбце Status показывается фильтр Filled и что 

отображаются только исполненные ордера. 
 

Пожалуйста, обратите внимание, нажатие левой кнопкой мыши на столбец будет 

автоматически сортировать данные по этому столбцу. 



42 
 

 

 

SETTINGS 

В окне Trading Monitor Settings (который находится в View - Settings), Вы сможете 

выбрать, какие столбцы данных, вы хотите увидеть. 

Обратите внимание, вы выбираете столбцы для каждой вкладки в Trading Monitor. 
 

Также есть Общие настройки (General): 
 

Пожалуйста, обратите внимание на параметры отображения. Чтобы показать свой 

статус Вы можете выбрать определенные цвета для ордеров. Например, частично 

выполненные приказы могут иметь свой собственный цвет. 
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Часть 8 – Информация по сделкам 

В платформе Sterling Trader® Pro окно Position Summary имеет схожий вид с окном 

Stock Watch. Здесь вы можете видеть свои открытые и закрытые позиции. 

Реализованная и нереализованная прибыль/убыток (P/L), количество 

проторгованных акций. И если у вас больше одной учетной записи, в этом окне вы 

можете видеть все свои позиции по всем счетам. 
 

COLUMNS 

В окне Position Summary вы получаете доступ к управлению столбцами во View - 

Settings. Пожалуйста, обратите внимание на специфические столбцы, которые 

помогут вам разобраться в деталях вашей сделки. Остальные столбцы более 

детально расписаны на нашем сайте. 

• Acct – счет (или счета, если вы торгуете несколькими учетными записями). 

• Pos – количество открытых позиций. 

• Last – цена последней сделки. 

• PosAvgPrc – средняя цена на текущие открытые позиции. 

• $Unreal – нереализованная прибыль/убыток. 

• $Real – реализованная прибыль/убыток. 

• $Total P/L – суммарная прибыль/убыток. 

• Inst – какой инструмент вы торгуете, в данном случае это акции. 

• Opg pos – открытие позиции, общее количество акций, перенесенных с 

предыдущего дня. 

VIEWING POSITIONS 

Есть несколько способов управления внешнего вида Position Summary. 
 

SORTING 

Щелчок левой кнопки мыши на один из заголовков столбца приведет к сортировке 

списка. Это позволит отсортировать список по этому столбцу. Во вкладке 

Miscellaneous вы можете выбрать, как часто будет происходить обновлением 

данных. 
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HIDING ROWS – скрытие строк. 

Если вы не желаете видеть какие-то позиции, либо символы, вы можете скрыть их, 

щелкнув правой кнопкой мыши по значку и выбрать скрыть позиции (HIDE ROWS). 

В дальнейшем вы можете управлять скрытием строк через Settings –  

Miscellaneous, нажав на "Only show entries which have a position". Это 

автоматически будет скрывать закрытые позиции. Однако если вы желаете видеть 

общую прибыль/убыток (P/L) и количество проторгованных акций – нажмите на 

"Include hidden rows in the Totals row calculations". 

 
FILTERS 

Вы можете отфильтровать определенные строки на основе критериев, которые вы 

установили. 

Добавление фильтра в окно Position Summary: 

1. Щелкните правой кнопкой мыши на заголовок столбца и выберите фильтр из 

всплывающего меню, затем выберите Add/Edit Filter.. 

2. В окне Add/Edit Filter выберите критерии фильтрации (в данном примере мы 

выбрали колонку Pos, где мы будем фильтровать размер позиции). 
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3. Мы выбрали условие фильтра, чтобы выделялись позиции с 500 и больше 

акциями. 

4. Нажмите кнопку Filter в верхней правом углу и фильтр будет удалять любые 

позиции с количеством акций меньше 500. 
 

 
5. Теперь у вас есть рабочий фильтр, вы можете его сохранить, загрузить, либо 

удалить. 
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Часть 9 – Линковка окон 

Множество окон в программе Sterling Trader® Pro имеют возможность линковаться. 

Чтобы убедиться, что окно имеет линковку, нажмите на меню Actions - Link 

Windows: 

 
 

Чтобы залинковать окна: 

1. Выберите одно окно, щелкните на меню Actions затем Link Windows. В 

примере мы используем окно Level II как окно, с которого начинаем линковку. 

2. Начинаете линковку с кнопок START, STOP, ADD TO GROUP или REMOVE 

FROM GROUP. 

3. Выберете START. Теперь Ваш курсор мыши будет иметь вид небольшой 

трехзвенной цепи. 

4. Нажмите на заголовке любого окна, которое вы хотите связать вместе. 

5. После того, как вы залинковали окна, вернитесь к меню Actions в окне Level II 

(с которого мы начали линковку) и щелкните Link Windows – Stop. Окна 

залинкованы. 

Вы увидите, что количество связанных окон образует группу - "Group". Вы можете 

добавлять или удалять окна из группы. Вы можете иметь столько связанных групп, 

сколько захотите (но окно может быть только в одной группе за раз). 

➢ Если вы связываете окно со Stock Watch, и вы хотите заполнить другие окна, 

нажав на символ в Stock Watch, вы должны установить Double-Click Event в 

окне Stock Watch - "Set Link Symbol". 
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Часть 10 – Stop-Limit ордер 

Stop-Limit ордер - тип ордера, который сочетает в себе свойства Stop и Limit ордеров. 

Исполнение ордера происходит по принципу поочередности, сначала происходит 

достижения уровня Stop ордера, после чего он конвертируется в Limit ордер. 

Пример. Выставляем Stop-Limit ордер на покупку, цена Stop – 256,90, цена Limit 257,00. 

Согласно принципу исполнения этого ордера, при достижении цены 256,90, ордер будет 

конвертирован в Buy Limit ордер на покупку по цене 257,00.  

Основное отличие Stop-Limit ордера от стандартных Stop ордера: Stop ордер после 

достижения цены конвертируется в маркет ордер и гарантирует его исполнение; Stop-Limit 

ордер после достижения цены конвертируется в Limit ордер и гарантирует его цену. 

 

Отправка Stop-Limit ордера: 

Для отправки Stop-Limit ордер в окне 

Level II справа от аккаунта укажите 

цену Stop, в окне справа от него 

выберите тип ордера S-STP, а в 

крайнем окне укажите цену Limit:  
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Часть 11 – Оставшиеся окна 

Все остальное из оставшихся окон: 

• Activity Log 

• Notification Log 

• Messenger 

• Clock 

Каждое окно служит определенной функции, не связанной непосредственно с 

ежедневной торговли (за исключением, возможно часов). Мы рассмотрим их по 

порядку. 

ACTIVITY LOG 

В этом окне, в хронологическом порядке, отображаются деятельность по торговому 

счету. Это может включать в себя ввод ордеров, а также изменения, внесенные 

менеджером на ваш счет. 

NOTIFICATION LOG 

Если у вас возникли проблемы с ордерами, это окно покажет вам журнал ошибок 

ввода ордеров, возникших в ходе торгового дня (вы также увидите эти ошибки, 

всплывающие на момент размещения ордера). 

MESSENGER 

Это окно мгновенного сообщения, используется для связи трейдер-трейдер или 

менеджер-трейдер. Окно не предназначено для обработки сделок. Это только окно 

чата. 

CLOCK 

Рыночные часы. Есть несколько параметров, которые можно изменить, они указаны 

ниже: 
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FAQ  
FAQ Sterling Pro находится на сайте: https://fondexx.com/study/faq-sterling-trader-pro 

1. Есть ли мануал по настройке торговой платформы? 

Руководство пользователя можно скачать по ссылке:  

https://fondexx.com/documents/SterlingTraderPro_user_guide.pdf 

 

2. Не отображается главное меню Sterling Trader Pro, также не могут открыть и 

другие окна, что делать? 

• Нужно свернуть все окна;  

• Навести курсор мыши на ярлык Sterling Trader Pro в нижнем трее; 

• Выбрать окно Главного меню и нажать правой кнопкой мыши – Переместить; 

• И с помощью стрелок на клавиатуре переместить Главное меню на рабочий стол. 

 

3. Как сделать классический вид Sterling? 

Для этого нужно зайти в главное меню, View -> Setting и поставить галочку Classic Mode. 

После чего выйти из платформы и снова в нее зайти: 

 
  

4. У меня не работает линковка с окна Stock Watch, как настроить? 

Для того чтобы работала линковка окна Stock Watch, необходимо в самом окне Stock 

Watch перейти во вкладку View -> Setting в окно -> Miscellaneous, в Other напротив Double-

click event выбрать: Set link symbol: 

  

https://fondexx.com/study/faq-sterling-trader-pro
https://fondexx.com/documents/SterlingTraderPro_user_guide.pdf
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5. Как настроить горячие клавиши: 

Для того чтобы настроить горячие клавиши необходимо перейти в главное меню, View -> 

Setting -> Hot Keys и поставить галочку Enable hot keys: 

 
После чего с помощью кнопки Add… добавляем и настраиваем необходимую горячую 

клавишу. Или же просто двойным кликом нажимаем по уже имеющимся горящим 

клавишам (которые с белым фоном) и в открывшемся окне также настраиваем горячую 

клавишу. 
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Ниже представлены примеры настройки горячих клавиш: 

Buy Market Order: 

  

 

Sell Market Order: 

  

 

Buy Limit Order: 

  

 

Sell Limit Order: 
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Buy Stop Order: 

  

 

Sell Stop Order: 

 
  

6. Как правильно нужно отправлять лимитные ордера на Post-market? 

Для того чтобы лимитные ордера отправлялись на Post-market Вам необходимо зайти в 

главное меню -View -> Settings -> Miscellaneous и снять галочку с "Auto-convert DAT orders 

to after-hours trading (EXT)": 
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7. Как правильно отправлять два отложенных ордера, Limit и Stop для фиксации 

прибыли/убытка? 

Пример. Если Вы находитесь в позиции Long, то можете поставить Sell Stop или Limit 

ордер только на тот объем, который в позиции уже есть. Остальной объем выставляется 

через Short. Другими словами, для отправки первого ордера нужно нажимать на кнопку 

«Sell», а уже второй ордер отправлять кнопкой «Short». 

 

8. Как правильно отправлять ордера OPG на открытие и закрытие?  

Для Pro клиринга: 

Ниже представлены подходящие Destination, TIF и Price для отправки ордеров OPG и CLO 

- особенно на открытия/закрытия. Пожалуйста, внимательно ознакомьтесь с ними: 

 

Destination: ARCAMOO/ARCAMOC 

TIF = DAY 

Price = MKT (Not MKT CLO) 

 

Destination: ARCALOO/ARCALOC 

TIF = DAY 

Price = Limit 

 

Destination: NSDQMOO/NSDQMOC 

TIF = DAY 

Price = MKT (Not MKT CLO) 

 

Destination: NSDQLOO/NSDQLOC 

TIF = DAY 

Price = Limit 

 

Destination: NYSEMOO/NYSEMOC 

TIF = DAY 

Price = MKT (Not MKT CLO) 

 

Destination: NYSELOO/NYSELOC 

TIF = DAY 

Price = Limit 
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9. Как в окне Level II выбрать по умолчанию основным аккаунт и ECN систему? 

Во-первых, нужно зайти в главном меню, View -> Settings -> Destinations и выбрать нужный 

аккаунт основным: 

 
 

Для того чтобы настроить нужный аккаунт основным по умолчанию в окне Level II нужно 

зайти в View -> Local Order Entry Settings ->, в Others -> Account: и выбираем нужный 

аккаунт. Также напротив Destination: выбираем необходимую ECN: 
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10.  Как настроить работу опционного аккаунта? 

После того как Вы получили опционный аккаунт его необходимо настроить.  

Для начала нужно зайти в главное меню, View -> Setting -> Destinations и выбрать напротив 

Equity логин с окончанием %INS, а напротив Options – логин с окончанием %OP: 

 
  

Для выбора опционного деска и отправки ордеров нужно выбрать в     главном меню: 

Windows -> Options -> Options Order Entry. 

Для того чтобы лента была соединена с опционным деском необходимо включить 

линковку в главном меню, View -> Setting -> Miscellaneous и поставить галочку напротив: 

Use option symbol for linked Time and Sales windows when available: 
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11.  Как изменить логин в Sterling Trader Pro? 

Кликните правой кнопкой мыши по ярлыку, далее свойства - Объект и после Pid: написать 

новый логин. 

 


